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e Safety precautions
Before you use the printer, carefully read the User’s manual to ensure that you use the printer
correctly. Be aware that the content complies with the standards at the time the User’s manual
section related to safety, including usage and safety precautions, was created.

e Modifications
To ensure product safety, modification of the ASK-400 printer and ASK-400 printer driver is
prohibited.

e Copyright
The copyrights, trademark rights, and other intellectual property rights related to documents and
programs included with this product are the property of FUJIFILM Corporation and other rights
holders. You cannot copy and use these items without the permission of FUJIFILM Corporation
except where permitted by applicable laws.

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the
United States and in other countries.

eAbout the country of delivery
Not for resale/use in the U.S.
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Chapter 1 Installation

Installation procedure

The installation procedure is made up of three steps.
The details of each step are explained below.

[ Step 1 Prepare the printer and computer — “1.1 Prepare the printer and computer” ]

At this point, the USB cable is not yet
connected.

\

[ Step 2 Install the driver package — “1.2 Install the driver package” ]
Q ﬁ Install the driver package.
[ Step 3 Install the printer driver — “1.3 Install the printer driver” ]

USB cable

Connect the USB cable, switch on the printer, and
then install the printer driver.
After installation is complete, restart the computer.

FUJIFILM Corporation
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1.1 Prepare the printer and computer

Make sure that the printer power is off.

Prepare a USB cable. However, do not use the USB cable to connect the printer and computer at this
time.

Log in to Windows as an administrator. The following explanation presumes that the operations are
carried out with administrator privileges.

CAUTION:
The display settings of the computer must be set as follows. If the settings differ from the
following, the printing preferences screen and other items may not fit in the display area.

- Resolution: At least 1280x800
- Size of text and other items (DPI): 100%

1.2 Install the driver package

Open Windows Explorer, and then click the corresponding drive.

Select one of the following driver package folders.
Driver package folder¥FUJIFILM ASK-400_Driver

B & B - | FUNFILM ASK-400_Driver

File Home Share View e
+ > FUNIFILM ASK-400_Driver ] O Search FUIIFILM ASKAD0-Driver
~
Name Date modified Type Size
Doc File folder
DriverPackage File folder
Driverlnstall. CMD Windows Cemma... 1KB
|J ReadMe_|nstall_English.txt Text Document 1KB
|:] ReadMe_|nstall_Japanese.txt Text Document 1KB
3 items =

Figure 1.2.1 Driver Package folder

FUJIFILM Corporation
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In the selected folder, double click the following file: Driverinstall. CMD. (Depending on your usage
environment, the .CMD extension may not be displayed.)

The driver package installer appropriate for your operating system (32-bit or 64-bit) is selected
automatically.

B & B - | FUIFILM ASK-400_Driver

File Home Share View o
T » FUNIFILM ASK-400_Driver v O £ Search FUNIFILM ASK400-Driver
Name - Date modified Type Size
Doc 3 PM File folder

DriverPackage 533 PM File folder

l Driverinstall. CMD l 01612:31 PM Windows Cemma... 1KB

D ReadMe_Install_English.bct 31 PM Text Document 1KB
D ReadMe_|nstall_Japanese.txt 32 PM Text Document 1KB

5 items =

Figure 1.2.2 Installation file

When you start the installer, a window appears for selecting the language that will be used during the
installation.  After you select the language to use, click “OK”.

FLUJIFILM ASK-400 - InstallShield Wizard

select the language for the installation from the choices below.

English {United States) v

Figure 1.2.3 Language selection screen

Click “Next >” when the Installation Wizard screen appears.

jiE FUNIFILM ASK-400 - InstallShield Wizard

Welcome to the InstallShield Wizard for
FUJIFILM ASK-400

The Installshield(R) Wizard will install FUJIFILM ASK-400 on
your computer. To continue, dlick Mext.

WARNING: This program is protected by copyright law and
international treaties.

< Back Cancel
Figure 1.2.4 Installation Wizard start screen

FUJIFILM Corporation
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Click “Install” when the installation is ready.

ji& FUJIFILM ASK-400 - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Badk. Click Cancel to
exit the wizard.

Installshield

< Back MR- Cancel
Figure 1.2.5 Installation start confirmation screen

When the installation starts, a screen appears that shows the installation status.

i FUJIFILM ASK-400 - InstallShield Wizard

Installing FUJIFILM ASK-400
The program features you selected are being installed.

Please wait while the Installshield Wizard installs FUJIFILM ASK-400. This
may take several minutes.

Status:

Installshield

Figure 1.2.6 Installation status screen

FUJIFILM Corporation
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When a User Account Control dialog box appears, click “Yes”.

User Account Control X

Do you want to allow this app from an
unknown publisher to make changes to your
device?

R [ P e
v il s T sl Wl i R A
SNCITIZEN CZ-01.msi

Publisher: Unknown
File origin: Hard drive on this computer

Show more details
( - ] " |

Figure 1.2.7 User Account Control

Click “Install” when the Windows Security confirmation display appears.

EE Windows Security

Would you like to install this device software?

MName: ASK-400
=% Publisher: FUIIFILM Corporation

Always trust software from "FUJIFILM Corporation”. l Install | E Don't Install i

@ You should only install driver software from publishers you trust. How can | decide
which device software is safe to install?

Figure 1.2.8 Windows Security confirmation

Installation of the driver package starts. Wait until installation finishes.
Click “Finish” when the Installation Wizard completion screen appears.

i'g":— FLUJIFILM ASK-400 - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed FUJIFILM
ASK-400. Click Finish to exit the wizard,

<gsck g bmsh ) Cancel

Figure 1.2.9 Finish of Installation Wizard

FUJIFILM Corporation
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1.3 Install the printer driver

Use the USB cable to connect the printer and computer, and then switch on the power of the FUJIFILM
ASK-400 printer.  After the printer is recognized, installation of the driver starts.
*For information on the connection, refer to the User Guide of the printer.

In Windows 7, if driver installation starts, the following message appears in the taskbar: “Installing
device driver software”.
In Windows 10, this message does not appear. Proceed to page 8.

“|| Installing device driver software * *
Click here for status,

Figure 1.3.1 Driver installation message

If you click on this message, the Install driver software screen appears and displays the installation
status of the driver. If Close is clicked, this screen closes.

ol :
__ Driver Software Installation (=
Installing device driver software
Photo Printer C Searching Windows Update...

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

. Close

Figure 1.3.2 Installing the driver software

*About the “Skip obtaining driver software from Windows Update” option

If your operating system is configured to obtain driver software from Windows Update, it may take time
for installation to complete because the process searches for drivers from Windows Update first. You
can reduce the time until the completion of installation by choosing to skip obtaining driver software
from Windows Update. (Depending on your operating system, it may take some time until installation is
complete.)

From the Driver Software Installation dialog box, click “Skip obtaining driver software from Windows
Update”.

__ Driver Software Installation @
Installing device driver software

Photo Printer {_ Searching Windows Update...

ight take a while.
Skip cbtaining driver software from Windows Update

Figure 1.3.3 Option to skip obtaining driver software from Windows Update

FUJIFILM Corporation
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A confirmation dialog box appears. Click “Yes”.

Driver Software Installation @

i Do you want to skip getting driver
— software from Windows Update?

Windows Update provides the |atest available driver
software which may work better for your device. You
can check Windows Update later for the latest driver
software, If you skip your device may not function at
all.

Figure 1.3.4 Confirmation to skip getting driver software from Windows Update

Soon after installation starts, a message appears in the taskbar stating “Your device is ready to use”,
and then printer driver installation finishes.

Device driver software installed successfully.

[ ] ; Your device is ready to use % *

Figure 1.3.5 Installation complete message

If you click on the message, the Driver Software Installation dialog appears, and the “Your device is
ready to use” message appears. Click “Close”.

(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar
message is not displayed.)

J Driver Software Installation @
Your device is ready to use

USE Printing Support —/ Ready to use
FUJIFILM ASK-400 +f Ready to use

[_Close_]

Figure 1.3.6 Completion of driver software installation

FUJIFILM Corporation
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Click “Start”, and then click “Windows System” -> “Control Panel” to open the Control Panel.
In Windows 7, click “Start”, and then click “Control Panel” to open the Control Panel.

In Control Panel, click “View devices and printers”.

Control Panel

. v A s Contral Panel

Eile Edit View Tools

Adjust your computer's settings

L o)
L

./ Hardware and Sound
Add a device
Adjust commonly used mobility
settings

System and Security

Review your computer's status

Save backup copies of your files with
File History

Backup and Restere (Windows 7)

Network and Internet
View network status and tasks

@

~. Programs
[_], Uninstall a program
Get programs

Search Control Panel

v &

View by: Category ~

User Accounts
M) Change account type

Appearance and
Personalization

Clock and Region
Change date, time, or number formats
Ease of Access

Let Windows suggest settings
Optimize visual display

Figure 1.3.7 Control Panel

In Devices and Printers, make sure that “FUJIFILM ASK-

400" is present.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the FUJIFILM

ASK-400 icon is not displayed.
This completes installation of the printer driver.

B Devices and Printers

- A Ha « Hardwar.. » Devices and Printers v @ 2 Search Devices and Printers
Add a device Add a printer See what's printing Print server properties = - o
~
FUIIFILM
ASK-400 v
FUJIFILM ASK-400 Status: 0 document(s) in queue
Q\/H Model:  FUIFILM ASK-400
Category:  Printer

Figure 1.3.8 Devices and

Printers screen

After the installation of the printer driver is complete, always restart the computer.

FUJIFILM Corporation
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In Windows 7, when the FUJIFILM ASK-400 printer driver could not be installed correctly, the following
message appears in the taskbar: “Device driver software was not successfully installed”.

“|'L Device driver software was not successfully installed * *
< Click here for details.

Figure 1.3.9 Message indicating that the driver was not installed

If you click on this message, the Install driver software screen appears and displays the message
“Device driver software was not successfully installed”. Click “Close”.

(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar
message is not displayed.)

When the driver could not be installed correctly, see the next section, 1.4, “Install drivers for unspecified
devices”, and then install the printer driver.

_'_! Driver Software Installation @
Device driver software was not successfully installed

USE Printing Support +f Ready to use
FUJIFILM ASK-400 x Mo driver found

What can I do if my device did not install properly?

Figure 1.3.10 When the driver was not installed correctly

FUJIFILM Corporation



[ASK-400 Printer Driver] Instruction Manual (For Windows 7, 10) .

1.4 Install drivers for unspecified devices

If you connect a printer that is on to the computer before installing the driver package, a device is
created under “Unspecified” in Devices and Printers.

5t Devices and Printers

= “ A Fw <« Hardware and Sound » Devices and Printers vl Search Devices and Printers yel

File Edit View Tools
Add a device Add a printer Remove device = - o

L

Photo Printer

Photo Printer  Model: Photo Printer
! Category:  Unknown

Figure 1.4.1 Photo Printer under Unspecified

In such a case, use the following method to install the printer driver.

Furthermore, use the following method to install the printer driver if you use the standard installation
procedure (install the driver package, connect the printer, and then install the printer driver), but the
driver is not installed correctly, and a device is created under “Unspecified”.

1. Install the driver package
When the driver package has not yet been installed, install it by following the procedure in 1.2, “Install
the driver package”.
If you install the driver package, installation of the printer driver for the unspecified device completes
it automatically.

2. Installing a driver for an unspecified device
After installing the driver package, the driver installation procedure for an “Unspecified” device is
different for Windows 7 and Windows 10.
For Windows 10, refer to page 11.
For Windows 7, refer to page 12.

10
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In Windows 10:
1. Right-click “Photo Printer” of the “Unspecified” device in “Devices and Printers”, and click “Remove
device” from the pull-down menu.

&H Devices and Printers

= “ A Fu <« Hardware and Sound » Devices and Printers v @ Search Devices and Printers el
File Edit View Tools

Add a device Add a printer Remove device = - o

Create shortcut

I G Remove device I

Troubleshoot

Photo Printer Properties

Photo Printer  Model:  Photo Printer
! Category:  Unknown

Figure 1.4.2 Delete “Photo Printer”

2. Disconnect the USB cable connected to the printer.
3. Restart your computer.
4. After starting up the computer, connect the USB cable again and turn on the printer.

In Devices and Printers, make sure that “FUJIFILM ASK-400" is present.

Note: When the printer is offline (the printer is not on and connected), the FUJIFILM ASK-400 icon is
not displayed.

This completes installation of the printer driver.

%t Devices and Printers

« v o s « Hardwar... » Devices and Printers v O A Search Devices and Printers

Add adevice  Addaprinter  Seewhat's printing  Print server properties = - @

Fax FUNIFILM
ASK-400 .
FUJIFILM ASK-400 Status: 0 document(s) in queue

Model: FUJIFILM ASK-400
Category: Printer

%

Figure 1.4.3 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

11
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In Windows 7:
In Devices and Printers, under Unspecified, right click on “Photo Printer’. From the menu, click

“Troubleshoot”.

[E=8 H=R =X

-
G =[% < Hardware and Sound + Devices and Printers ~ [ 43 |[ Search Devices and Printers )

Add a device  Add a printer

4 Unspecified (1)

Create shorteut

e A8
Troubleshoot
Properties 1

Photo Printer | s

= Phato Printer  Model: Photo Printer
Category: Unknown

Figure 1.4.4 Photo Printer under Unspecified

The Install a driver for this device screen appears. Click “Apply this fix”.
The computer searches for a driver automatically, and then installs it.

\_.J [ Devices and Printers

Install a driver for this device

The driver for FUIFILM ASK-400 is not installed. Install the latest driver for the device,

[ = Apply this fix ]

= Skip this fix
Continue troubleshooting without applying this fix.

Cancel

Figure 1.4.5 Applying a fix

12
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If the driver is installed, the message “Troubleshooting has completed” appears. Click “Close the
troubleshooter” to close the troubleshooting window.

Q [ Devices and Printers

Troubleshooting has completed

Troubleshooting was unable to automatically fix all of the issues found. Yeu can find more
details below.

Problems found
FUJIFILM ASK-400 doesn't have a driver Fixed .@
FUIFILM ASK-400 is not the default printer Fixed -@

= Explore additional options

[fb Close the troubleshooter ]

Wiew detailed information

Figure 1.4.6 Completing troubleshooting

In Devices and Printers, make sure that “FUJIFILM ASK-400" is present.
This completes installation of the printer driver.

= E =]
=
@\J'lm <« Hard... » Devices an.. [ 43| [ Search Devices and Printers o]
Add a device Add a printer See what's printing > = - @-

-~

i &
 FUIFLM
ASK-400

mn |

FUJIFILM ASK-400 State: (@) Defaule
Model: FUJIFILM ASK-400

"I/I Category: Printer

Figure 1.4.7 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

13
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Chapter 2 Properties

You can configure various printer settings from the Properties of the driver. Make sure you understand
the contents well before changing settings. To use the properties, log in as an administrator.

Depending on the application you are using, you must perform this operation from the print settings of
the application.

2.1 Open the printer properties

1. Click “Start”, and then “Windows System” -> “Control Panel” -> start “Control Panel”
In Windows 7, click “Start” -> “Control Panel” -> start “Control Panel”

B Windows Media Codec Pack
Bl Windows Media Player

B Windows Powershell

. Windows System

‘Command Prompt

Control Panel

Run

Task Manager

P File Explorer
F
=

This PC

2. From the Control Panel, click “View devices and printers” to open the Devices and Printers

EE Control Panel a

« v » Control Panel » w & | Search Control Panel »

File Edit View Tools

Adjust your computer’s settings View by: Category ~
System and Security User Accounts
Review your computer's status & Change account type

Save backup copies of your files with
File History B2 Appearance and
Backup and Restore (Windows 7) Personalization
. ==
¢ Network and Internet
View network status and tasks »:*
nd Sound -

evices and printers

5 Oevice

Clock and Region

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

Adjust commonly used mobility

settings

«. Programs

[_], Uninstall a program
Get programs

14
FUJIFILM Corporation



[ASK-400 Printer Driver] Instruction Manual (For Windows 7, 10) .

3. Right click “FUJIFILM ASK-400” icon. From the menu, click “Printer Properties” to open the
Properties dialog box.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the
FUJIFILM ASK-400 icon is not displayed.

B Devices and Printers

« ~ 4 Fa <« Hardware and Sou... > Devices and Printers v O L Search Devices and Printers

Addadevice  Addaprinter  Seewhat's printing  Print server properties  Remove device =~ @

See what's printing

@ Set as default printer

Printing preferences

Printer properties

FUNIFILM
ASK-400 Create shortcut

) Remove device

Troubleshoot

Properties

FUJIFILM ASK-400 Status: 0 document(s) in queue

Model:  FUJIFILM ASK-400
Category: Printer

4. The FUJIFILM ASK-400 Properties screen appears.

#m FUIIFILM ASK-40D Properties

General Sharng Pots  Advanced Color Management Securty

== [FUJIFILM ASK-400f |

Location: |

Comment:

Maodel: FUJNIFILM ASK-400
Features
Color: Yes Paper available:

Double-sided: No (6xd)

Staple: No

Speed: Unknown

Maximum resolution: 600 dpi

Preferences... Print Jest Page

Coca || i

15
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2.2 Print settings functions

If you select the basic settings from the Properties screen, you can change various print settings.

2.2.1 Layout

4= FUJIFILM ASK-400 Printing Preferences

Layout | Paper/Qualty Option Color Adustment ~ Priter nfo

=
Figure 2.2.1 Layout tab

Orientation

Set the print orientation to “Portrait” or “Landscape”.
For details, refer to “2.6 Orientation”.

Page Order
In the application, specify the order when multiple copies of an image are printed.

Example) Print order No.1 No.2 No.3

Front to Back

Back to Front

Page Format

Pages per Sheet
Set printing of the specified division size. In most situations, set “1”.

Example) Division size 1 division 4 divisions 9 division

16
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2.2.2 Advanced options

If you select “Advanced...” on the Layout tab, you can configure various advanced options.

2 FUIFILM ASK-

FUJIFILM ASK-400 Advanced Options

Layout  Paper/Quaity Opton Color Adustment  Prter info

Qrientation:

= FUJIFILM ASK-400 Advanced Document Settings
4] Paper/Output
Copy Count: 1 Copy
n] Graphic
. Print Quality: High-speed
E| @ Image Coler Management
[ e ICM Method: ICM Handled by Host System
P e ICM Intent: Pictures
£-fi Document Options
i Advanced Printing Features: Enabled
Pages per Sheet Layout: Right then Down
P E| % Printer Features
---------- Border: Disable
Overcoat Finish: Glossy
.......... Print Re-try: Enable
2inch cut: Disable

Cancel
Cancel oply
Figure 2.2.2.1 Advanced settings

Figure 2.2.2.2 Advanced options tab

Paper/Output

Paper Size

Specify the paper size. Match the paper size with the size of the media set in the printer.

You can enable multiple layout settings by setting the paper size. See later sections for details.
Copy Count

You can specify the number of copies to be published for images.

17
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Graphic
Print Quality
Specify the resolution.
Print quality Function
High-speed Print using high speed mode
High-quality Print using high quality mode
ICM Method
ICM Method Function
ICM Disabled Synchronized with “Color Adjustment Disabled” in the 2.2.4
Option.
ICM Handled by Host System Synchronized with “Color Adjustment ICM” in the 2.2.4 Option.
Manage colors using the driver.
ICM Handled by Printer When this item has been selected, operation is the same as
“ICM Handled by Host System”.
ICM Intent

Set the rendering method when using ICM. For the ICC profile, always set to “Pictures”.
Do not use other settings.

Document Options

Advanced Printing Features
Always set Enable. Do not use other settings.

Pages per Sheet Layout
Set the layout direction of an image when the Pages per Sheet setting is set for multiple divisions.

Printer Features

Border
Synchronized with Border in the Option.

Overcoat Finish
Set the overcoat finish method for the surface of printed items from the following four types.

Overcoat Finish Function
Glossy Create an item with a glossy finish.
Matte Create an item with a matte finish.
Luster Create printouts with rough surface and semi-gloss finish that
has less glare.
Fine Matte Create printouts with fine grain and strong matte finish.

*Sticker paper can only print with a glossy finish. Even if settings are set to an overcoat finish other
than glossy, these settings will not be applied.

18
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Print Re-try
Specify whether to print data in the printer buffer after a printer error has been cleared.
Print Re-try Function

Disable Clear the print data in the printer buffer when a printer error occurs.
You must send the cleared print data again after the error is cleared.
When you use an application with an error recovery function, select this
option.

Enable Save print data in the printer buffer when an error occurs.

cleared.

The printing process is restarted from the saved data after the error is

Note that if the power is switched off, the data is not saved.

Depending on the content of the printer error, it may be necessary to restart the printer to clear the
error. In such cases, the print data in the printer buffer is cleared regardless of the Print Re-try

setting.

The following section shows the operation for each Print Re-try setting by error.

Error content

When Print Re-try is disabled

When Print Re-try is enabled

Paper end

You must send the unprinted image

Ribbon end

data again after the error is cleared.

Cover open

Paper jam (*1)

Ribbon error (*1)

Paper setting error

The printing process is restarted from
the data saved in the printer buffer
after the error is cleared.

When the paper initialization
operation is to be carried out, printing
occurs afterwards.

Data error

Because the printer must be switched

Head voltage error

on and off to clear the error, the print

Head position error

data in the printer buffer is cleared

Power supply fan stopped

regardless of the Print Re-try setting.

Cutter error

Head temperature error

After the printer has restarted, you

Media temperature error

must send the unprinted image data

RFID module error

again.

System error

Because the printer must be switched
on and off to clear the error, the print
data in the printer buffer is cleared by
switching the printer off, even when
the Print Re-try setting is Enabled.

After the printer has restarted, you
must send the unprinted image data
again.

*1: After the printer stops due to an error, follow the user’s manual of the printer to eliminate the cause of the

paper or ribbon error.

2inch cut
Specify whether to cut paper into multiple sheets with a 2-inch length when you use a specified
paper size.
2inch cut Function
Disable Cut at the normal size.
Enable Cut at 2-inch lengths so that the 6x4 size becomes two sheets and the

6x8 size becomes four sheets.

19
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< Multiple layout >

When 5x7, 6x8 or 6x9 media is used, you can use a two-picture layout.
You can enable multiple layout settings by setting the paper size of the printer driver.
If it sends multiple images from the application, the printer driver allocate them automatically as the

multiple layout.

The following section shows the image sizes.

Layout settings

Driver paper size setting Paper direction IengtrF: ?(p:éizlifte(mm) Media used

(5x3.5) Portrait 131.1x 92.1 5x7, 6x8, 6x9
Landscape 92.1x131.1

PR (3.5x5) Portrait 92.1x131.1
Landscape 131.1x 92.1

(6x4) Portrait 156.1x105.0 6x8, 6x9
Landscape 105.0x156.1

PR (4x6) Portrait 105.0x156.1
Landscape 156.1x105.0

(6x4.5) Portrait 156.1x117.3 6Xx9
Landscape 117.3x156.1

PR (4.5x6) Portrait 117.3x156.1
Landscape 156.1x117.3

Multiple layout is carried out under the following conditions.
1. Set 5x7, 6x8 or 6x9 size media in the printer.
2. Set the paper size of the printer driver to one of the abovementioned paper sizes.

3. From the application, send multiple images.

Note) Depending used conditions, the rewinding print might be carried out instead of the multiple

layout.

Because they are carried out by the print job, multiple layout are carried out when there
are multiple images in a single job.
If you want to layout the same image, send the same number of images as the umber-of-sheets

setting.

The printer handles two pictures at one time and cuts the paper after it is ejected.

Cut when paper is ejected

20
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<Rewind Print function >
If you set the paper size setting to (6x4) when printing 6x4 size to 6x8 size media, printing is
optimized to reduce consumption of the ribbon.

Furthermore, if you set the paper size setting to (5x3.5) or (6x4.5) when printing 5x3.5 size to 5x7
size media or when printing 6x4.5 size to 6x9 size media, printing is similarly optimized to reduce
consumption of the ribbon.

The following shows the difference in ribbon consumption when the paper size is set to (6x4) for
6x8-sized media.

ASK-400

When printing one sheet at
6x4 size once

Used for the
next printing

*After printing, the ribbon is rewound and adjusted to the next print position.

When printing one sheet at
6x4 size twice

*After the first sheet is printed, the ribbon is rewound, and the second sheet is printed.

When printing two sheets
at 6x4 size once

9

*Two sheets are printed at the same time in a multiple layout.

When printing one 6x4 size
sheet once, and then
printing two 6x4 size sheets
once

Used for the
next printing

b

*After the first sheet is printed, the ribbon is rewound, and the second and following sheets are
printed. Furthermore, after the third sheet is printed, the ribbon is rewound and adjusted to the next
print position.
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< Application usage example >
This usage example uses Windows Explorer.

Step 1. In Windows Explorer, select two or more pictures.
Next, click "Print".

Manage Pictures

File Home  Share  View Picture Taols

|j “f o Moveto~ ¥ Delete = T

PintoQuick Copy Paste _ [ElCopyto~ (=[Rename MNew Properties
access 6] folder - &

P - HHselectan

27 Select none

£ Invert setection
Clipboard Organize Hew Open Select

<« © 4 ||« Pictures o

v 2 Search Pict..

Open

Create a new video

Edit with Photos.

Edit with Paint 3D

Set as desktop background
. Edit

Select images G=)

Rotate right

Rotate left

2items 2 items selected 6.76 MB e — S =

521016 521070

Step 2. Select "Fit picture to frame" check box, and then
click "Options...".

=
How do you want to print your pictures?
Printer: Paper size: Quality: Paper type: P
FUJIFILM ASK-400 v |(6x4) v | High-speed

~| | Plain Paper v

Full page photo
10f 1 page
Copies of each picture: [ 1 Fit picture to frame Obfionsa;

Step 3. Click "Printer Properties...".

Print Settings

Sharpen for printing

Only show options that are compatible with my printer

Certain combinations of paper type, paper size, and print quality may
not print well or be available with all printers. Limiting your options to
only those that are compatible will give you the best results,

Color Management...

Printer Properties...

“med
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Step 4. Set the Orientation to Portrait,
and click "Advanced...".

/2 FUIIFILM AS

Layoust  Paper/Quaity Option Color Adiustment  Printer Info

Orientation:

(Em—— )
Page Order:
Frontto Back -
Page Format
Pages per Sheet
Draw Borders

Cancel Loy

Step 5. Set the paper size to the setting of the multiple layout.
Click OK twice to close the dialog boxes in Step 5 and 4.

FUJIFILM ASK-40! vanced Options

8 FUIIFILM ASK-400 Advanced Document Settings
(£-+1] Paper/Output
&8 v
....... Copy Count (5,3.5)
=[] Graphic (55)
------- Print Quality (5x7)
=-{E) Image Colol

1CM Mef (6x4.5) ed by Host System
ICM Inte (6x6)
=-f Document Opti (6x8)
....... Advanced p| (6x2) Enabled

------- Pages per S PR (3.5¢5) ht then Down
-6 Printer Feat| PR (4+-3¢6)
L PR (4x6)

Border:

Overcoat Finish: Glossy
Print Re-try: Enable
Zinch cut: Dissble

OK I Cancel

Step 6. Click the Print button.

X
=
How do you want to print your pictures?
Printer: Paper size: Quality: Paper type: ®
FUJIFILM ASK-400 v |(6x4) v | |High-speed | Plain Paper v
Full page photo
10f 1 page

Copies of each picture: | | Bt picture to frame Bitionsd

ll Cancel
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2.2.3 Paper/Quality

Loyt Poper/Oualty Opton Color Adhsimert Prvter ks

Color

- _f © gk & white

Adyanced.

o] [ canee

By

Figure 2.2.3 Paper/Quality tab

Color

Set Color. Do not use black and white.

2.2.4 Option

0 (Defauk)

Color Adjustment
ONoney

Layout  Peper/Qualty 0P | Color Adusiment _ Preter ko

[Border

Sharpness(t)

Color Adjustment | 7 fpion

O Handled by Driver(l) O Noneily
@ O1CM & Driver)
Langusgeill): English
About(E)..

@MY

Language(l):

Defaut@)

Cancel

Figure 2.2.4.1 Option tab

Bevly

-
Figure 2.2.4.2 Sharpness setting
Border

Specify a border for printing. (Select the check box for a border.) Synchronized with Border
Enable/Disable in the Advanced settings.

Sharpness

Process sharpness using one of the 11 stages (Figure 2.2.4.2).
(+) side sharpens the image.

If the setting is “0 (Default)”,
sharpness is not processed. Moving to the minus (-) side blurs the image and moving to the plus
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Color Adjustment

None
Synchronized with the ICM Method in the Advanced settings. If this check box is selected,
ICM is disabled, the Color adjustment tab is also disabled, and the printer driver does not
carry out color adjustment.

Handled by Driver
If this check box is selected, ICM is disabled, and the 2.2.5 Color Adjustment is enabled.
The result is applied to the adjustment values of the following items: Gamma, Brightness,
Contrast, and Chroma.

ICM
Synchronized with the ICM Method of the Advanced settings (ICM Handled by Host System).
If this check box is selected, the driver manages colors.

ICM & Driver
If this check box is selected, ICM (color management) and the 2.2.5 Color Adjustment are
enabled.

Language
Change the display language for the following items: Option, Color Adjustment, and Printer Info.
The selected language is enabled the next time the print settings are displayed.

[Available languages]

- Japanese

- English (US)

- French (France)

- German (Germany)

* Russian (Russia)

+ Spanish (Spain)

- Korean

- Chinese (People's Republic of China)
- Chinese (Taiwan)

+ When your operating system environment corresponds with one of the above settings, the default
display language is the language of the corresponding country. Furthermore, when your
operating system environment does not correspond with one of the above settings, the default
display language is English.

- To use a language different from that of your operating system, you must install the following font for
the corresponding language.

Language Font
Japanese Meiryo / Yu Gothic Ul <Windows10>
English (US) Segoe Ul
French (France) Segoe Ul
German (Germany) Segoe Ul
Russian (Russia) Segoe Ul
Spanish (Spain) Segoe Ul

Korean

Malgun Gothic

Chinese (People's Republic of China)

Microsoft YaHei

Chinese (Taiwan)

Microsoft JhengHei

About

Show the driver version.
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2.2.5 Color Adjustment

If the Handled by Driver check box is selected in the 2.2.4 Option, the adjustment values of the Color
Adjustment tab are applied to the image.

L —

nnnnnn

DefauhtD)
LosdL).

Save(s).

I

Figure 2.2.5 Color Adjustment tab

The following section shows the setting ranges on the Color Adjustment tab.

Adjustment item

Adjustment value

Gamma

-100 (dark) to 100 (bright) (“0” results in no adjustment, y2.0 to 0.5)
Adjust the density of the half-tone section of the image. Increasing the gamma
value brightens the half-tone section.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Brightness

-100 (dark) to 100 (bright) (“0” results in no adjustment)
Adjust the brightness of the image. Increasing the brightness value brightens
the entire image.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Contrast

-100 (weak) to 100 (strong) (“0” results in no adjustment)
Adjust the contrast of the image. Increasing the contrast value increases the
difference of brightness and darkness.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Chroma

-100 (weak) to 100 (strong) (“0” results in no adjustment)
Adjust the chroma of the image.
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2.2.6 Printer information

View the printer information.

/5t FUJIFILM ASK-400 Printing Preferences

Layout Paper/Qualty Opfion  Color Adjustmert  Piter Info Layout  Paper/Quaity Option  Color Adustmert  Prnter ifo
MediaInfo

Media Info
400 / 400 Sheets

o/ - Sheets
6cdin

0% 0% 100% 0% 50% 100%
Papertype STANDARD Paper type
Printer Status Printer Status
[ waiting [ waiting
o
= = << Incorrect medi type s been loaded. >»
— —

Total Count Firmware Version

Total Count Firmmare Version
207 ASK4DD 01.00

207 ASKA0001.00
Serial No, Serial No,

Color Control Data Color Control Data
Version Checksum Version Checksum
300dpi ASK400_PD_300_0100.CWD 2887 300dpi ASK400_PD_300_0100.CWD 2887

600dpi ASK400_PD_600_0100.CWD FD22 600dpi ASK400_PD_500_0100.CWD D22
Low Speed ASK400_PD_510_0100.CWD 5479 Low Speed ASK400_PD_610_0100.CWD 5479

Update(U) Update(l)

Cancel ooy
Figure 2.2.6.2 Display when incorrect media is loaded

Cancel Bosly

Figure 2.2.6.1 Printer Information tab

The following section shows the information displayed in the Printer Info tab.

Display item Display details

Media Info This area shows, for example, the size and remaining number of printable
sheets for the ribbon media and the paper type in the printer.

* Media information is not displayed when a media type not supported by the
printer has been loaded. (Figure 2.2.6.2)

Printer Status Displays the status of the printer using icons and characters.

Display icon  Display Status/Response
(Color) characters

@ Waiting Printing is possible.

Pt

(Green)

g Printing The printer is printing.

—

(Blue)

Door open Front door is open.
Close the front door.

—

(Yellow)
Ribbon end No ribbon remains.
Load new media.
% (Replace the paper and ribbon as a set.)
(Yellow)
Paper end No paper remains.
Load new media.
(Replace the paper and ribbon as a set.)
-
(Yellow)
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Display item

Display details

Printer Status

Display icon  Display Status/Response
(Color) characters
Offline The printer cannot be recognized.
Connect the printer and computer, and then turn
on the power.
(Gray)
— Cooling head The head is being cooled.
N Please wait a while. Printing will resume
[o==p automatically.
e
(Purple)
Ribbon error The ribbon is not set correctly.

— Reload the ribbon properly.

(Orange)
— Paper size The printer settings and size of the installed
o setting error ribbon do not match.
o Check the paper size setting and ribbon size.
(Orange)
. Paper jam A paper jam was detected. _
Y Remove the paper and reload it properly.
._8./\,
(Orange)
System error System error.
Restart the printer and computer. If the printer
does not recover after the restart, contact the
— service center.
(Red)

* A warning message is displayed when a media type not supported by the
printer has been loaded.(Figure 2.2.6.2)

Total Count

Total count of printed sheets.

Firmware Version

Version of the control program of the printer. xx.xx indicates the version.
+ ASK400 xx.Xx

Serial No.

Serial number of the printer.

Color Control Data

Printer color control data.
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2.3 Default values for settings

The following section shows the default values of the settings (at installation). If the settings have

been changed, and the printer driver no longer operates normally, return to the default values shown

below.

Note) Depending on the service pack of your operating system or your usage environment, the default
values at installation may differ from those in the chart below.

Chart 2.3 Default print settings

Tab Setting Value
Orientation Portrait
Layout Page Order Front to Back
Pages Per Sheet 1
Paper/Quality Color Color
Border Disable
: Sharpness 0 (Default)
Option Color Adjustment ICM
Language setting English
Gamma 0
Color Brightness 0
Adjustment Contrast 0
Chroma 0
Paper Size (6x4)
Paper/Output Copy Count 1 Copy
Print Quality High-speed
; Image ICM Handled by Host
h ICM Method
Advanced Graphic Color System
settings Management | ICM Intent Pictures
E'T)th?, Lkayout Advanced Printing Features Enabled
ab, clic
“Advanced...”) Pages per Sheet Layout Right then Down
Document Border Disable
options Printer Overcoat Finish Glossy
function Print Re-try Disable
2inch cut Disable
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2.4 Color management

Use Color management to specify the color profile. The installer associates “ASK400_xxxx.icc” by
default.

Step 1. From the Printer Properties, select the Color Management tab, and then click “Color
Management...”.

£t FUJIFILM ASK-

General Sharing Pots  Advanced Color Management  Security.

E‘ To adjust color management settings, ciick Color Managemert.
-

Color Manage

OK Cancel Apply

Figure 2.4.1 Color Management Tab

Step 2. From Device, select “FUJIFILM ASK-400".

3 Color Management

Devices  All Profles  Advanced

Device: ﬂ(PvmtEn FUJIFILM ASK-400

[0 Use my settings for this device

Identify monitors
Profile selection: Automatic (Recommended)

Profiles associated with this device:

Name File name
ICC Profiles

ASK400_0050 ASKAD0_0050.icc
ICC Profiles (Advanced Coler)

ASK400_0050 A’Wc

The installer associated this file

Add...

Remove

Set as Default Profile

Understanding color management settings Prefiles

Figure 2.4.2 Color Management Window
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2.5 Print Area

The following section shows the image sizes and numbers of dots generated by the paper size setting

of the driver.

Image size Number of image dots
Paper size Orientation : (icithibdlieibhi) High-spe(;vjjdth Z heigl-rl]igh-quality
(len) () (300x300 dpi) | (600x600 dpi)*1

Portrait 5"x3.5” 131.1x92.1 1548 x 1088 3096 x 2176
(5x3.5) Landscape 3.5"x5" 92.1x131.1 1088 x 1548 2176 x 3096
Portrait 5" x 5" 131,1 x 130,4 1548 x 1540 3096 x 3080
(5x3) Landscape 5" x5’ 130,4 x 131,1 1540 x 1548 3080 x 3096
Portrait 5" x7” 131.1x 181.0 1548 x 2138 3096 x 4276
(5x7) Landscape 7" x5 181.0x 131.1 2138 x 1548 4276 x 3096
Portrait 6" x 4” 156.1 x 105.0 1844 x 1240 3688 x 2480
(6x4) Landscape 4” x 6” 105.0 x 156.1 1240 x 1844 2480 x 3688
Portrait 6"x 4.5” 156.1 x 117.3 1844 x 1386 3688 x 2772
(6x4.5) Landscape 4.5"x 6” 117.3 x 156.1 1386 x 1844 2772 x 3688
Portrait 6” x 6” 156.1 x 155.4 1844 x 1836 3688 x 3672
(6x6) Landscape 6" x 6” 155.4 x 156.1 1836 x 1844 3672 x 3688
Portrait 6" x 8” 156.1 x 206.2 1844 x 2436 3688 x 4872
(6x8) Landscape 8" x 6" 206.2 x 156.1 2436 x 1844 4872 x 3688
Portrait 6"x 9” 156.1 x 232.0 1844 x 2740 3688 x 5480
(6x9) Landscape 9"x 6” 232.0 x 156.1 2740 x 1844 5480 x 3688
Portrait 3.5 x5 92.1x131.1 1088 x 1548 2176 x 3096

PR (3.5x5)
Landscape 5" x3.5” 131.1x 92.1 1548 x 1088 3096 x 2176
PR (4x6) Portrait 4” x 6” 105.0 x 156.1 1240 x 1844 2480 x 3688
Landscape 6” x 4" 156.1 x 105.0 1844 x 1240 3688 x 2480
Portrait 4.5"x 6” 117.3 x 156.1 1386 x 1844 2772 x 3688

PR (4.5x6)
Landscape 6"x 4.5” 156.1 x 117.3 1844 x 1386 3688 x 2772

*1: Convert to 300 x 600 dpi size within the driver, and then send to the printer.
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2.6 Orientation

The following chart shows the relationship of images generated by an application and printed items

(output direction) according to the orientation setting.

Hint: The PR print size (center column) is prepared for applications that are not able to change from

landscape to portrait and back using the orientation setting on the layout tab. Normally it is

recommended to use the non-PR print sizes and use the orientation settings for landscape and portrait
on the layout tab.

Original Driver settin
image Orientation | Paper setting
(5x3.5) PR (3.5x5) (5x7)
(5x5) PR (4x6) (6x8)
(6x4) PR (4.5x6) (6x9)
(6x4.5)
(6x6)
CEiEEE Printed item CEnaEE Printed item e Printed item
image .(OUtPUt image .(OUtPUt image .(OUIPUI
orientation|) orientation|) orientation|)

Portrait

Landscape

Portrait

Landscape
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Chapter 3 Update the driver

As when performing the installation, log in as an administrator before carrying out this operation.
1. Check the job

1) Before updating the printer driver, close all applications. Furthermore, click on the icon of the
printer to be updated in the Devices and Printers screen. At the bottom area of the screen,
confirm that there are no documents in the queue, and then start update of the driver.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the FUJIFILM
ASK-400 icon is not displayed. Always connect the printer with the power turned on and
check that there are no documents in the queue.

%l Devices and Printers

« “ 4 Fw « Hardwar.. > Devices and Printers v | D 2 Search Devices and Printers

Add a device Add a printer Seewhat's printing Print server properties  » = - o

Fax FUJIFILM
ASK-40D v
FUJIFILIW ASK-400 Status: 0 documentis) in gueue
Q/a Model:  FUJIFILM ASK-400

Category:  Printer

Figure 3.1 Clicking the FUJIFILM ASK-400 icon at the Devices and Printers screen
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2. Uninstall the driver package

1) Click “Start”, and then click “Windows System” -> “Control Panel”. In the Control Panel, click
“Uninstall a program”.
In Windows 7, click “Start”, and then click “Control Panel”. In the Control Panel, click “Uninstall a
program”.

EE Control Panel

B Windows Media Codec Pack

Bl Windows Media Player € v 4 & Control Panel » v\ & | Search Control Panel o
Fle Edit View Took

l Windows PowerShell

Adjust your computer’s settings Viewby: Cat
B Windows System jjust y p g iewhby: Category ¥

Change date, time, or number formats
o L ./ Hardware and Sound
= ThisPC - View devices and printers
Add 2 device
Adjust commonly used mobility
settings

s, Programs
[.). Uninstzll a program

Get programs

Ease of Access
Let Windows suggest settings
Optimize visual display

Command Prompt ‘ System and Security User Accounts
Review your computer's status a
Ch t
BE Control Panel Save backup copies of your files with  Change zccount type
3 File History &5 Appearance and
H File Explorer Backup and Restore (Windows 7) Personalization
B Run MNetwork and Internet & Clock and Regi
View network status and tasks :5 ock and Region

Figure 3.2 Control Panel

2) The Uninstall or change a program screen appears. In the list, double click “FUJIFILM ASK-400".

ol Programs and Features

- v Ei < Programs » Programs and Features ] 2 Search Programs and Features

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair,

G Turn Windows features on or

off Organize »  Uninstall Change  Repair Ea o
- Publiher »
' FUJIFILM ASK-400 FUIIFILM Corporation )
v
£ >

FUJIFILM Corporation Product version:
' Size: [pms——

Figure 3.3 Uninstall a program
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3) Click “Yes” when the FUJIFILM ASK-400 uninstall confirmation windows appears.
Uninstalling the driver is complete. After uninstalling the printer package, restart the computer.

Programs and Features

I Are you sure you want te uninstall FUJIFILM ASK-4007

] In the future, do not show me this dialog box Yes

Figure 3.4 Uninstallation confirmation

When a User Account Control dialog box appears, click “Yes”.

User Account Control *
Do you want to allow this app from an
unknown publisher to make changes to your
device?

1 P Rl TR S

Publisher: Unknown
File origin: Hard drive on this computer

Show more details
[ Yes ] No |

Figure 3.5 User Account Control

3. Install an upgrade for the printer driver

After deleting the printer and the printer driver, install the new printer driver. For the installation
procedure, see “Chapter 1 Installation”.

4. Restart the computer

After the installation of the printer driver is complete, always restart the computer.
(Do not print just after installation. Always restart the computer once.)
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Chapter 4 Delete the driver
4.1 Automatic deletion of printer drivers

The printer driver is automatically deleted when uninstalling the driver package.
For the steps to uninstall the driver package, see “2. Uninstall the driver package” in Chapter 3.

Note that uninstalling the driver package when the printer driver is in use will display the following
message, and the printer driver will not be deleted.

FUJIFILM ASK-400 Printer Driver Uninstaller

' The specified printer driver is currently in use.
’

Figure 4.1 Message displayed when the driver is in use

When the above message is displayed, restart the computer and then delete the printer driver using the
procedure described in “4.2 Manual deletion of printer drivers”.
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4.2 Manual deletion of printer drivers

1) Click “Start”, and then click “Windows System” -> “Control Panel”. In the Control Panel, click
“View devices and printers”.
In Windows 7, Click “Start”, and then click “Control Panel”. In the Control Panel, click “View
devices and printers”.

From the Devices and Printers screen, right click the FUJIFILM ASK-400 printer. From the menu,
click “Remove device”.

At Devices and Printers

&« A s < Hardware and Sou... » Devices and Printers v 0 2 Search Devices and Printers

Add a device Add a printer See what's printing Print server properties Remove device = - o

See what's printing
@ Set as default printer
Q\/ Printing preferences

Printer properties

FLUIFILM

ASK-400 Create shortcut
G Remove device )
Troubleshoot
Properties
FLUIFILM ASK-400 Status: 0 document(s) in queue

Model:  FUJIFILM ASK-400
Categony:  Printer

Figure 4.2.1 Right clicking FUJIFILM ASK-400 in the Devices and Printers screen
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In Windows 10, when the printer is offline (the printer is not on and connected), the FUJIFILM
ASK-400 icon is not displayed. In such cases, use the following procedure to delete the device.

(i) On an empty area in the Devices and Printers screen, right click, and then select “Device

Manager”.
View >
Sort by >
Group by >
Refresh
Paste

Paste shorteut

Add devices and printers

) Device Manager

Figure 4.2.2.i Right clicking on an empty area in the Devices and Printers screen

(ii) Click View, and then select “Show hidden devices”.

& Device Manager

File Action View Help

4@ = | 5| 8 Devices bytype
Devices by connection
Devices by contsiner
Resources by type
Resources by connection

~  Show hidden devices

Customize...

Figure 4.2.2.ii Displaying the View menu for hidden devices

(iii) Under Printers, right click FUJIFILM ASK-400, and then select “Uninstall device”.

u'j Device Manager

File Action View Help
e @ EH BB REXx®
~ [ Printers
= FUJIFILM ASK-400

] Processors
B Software devices
i Sound, video and gai Uninstall device )
S Storage controllers
K= System devices
§ Universal Serial Bus cc Properties

Figure 4.2.2.iii Displaying the menu to delete FUJIFILM ASK-400

Update driver

Disable device

Scan for hardware changes

(iv) At the Uninstall Device screen, click “Uninstall”.

Uninstall Device

== FLUIFILM ASK-400
==

Waming: You are about to uninstall this device from your system.

[JDelete the driver software for this devies

([ trinsial_|) | cancel

Figure 4.2.2.iv Uninstall Device screen
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2) The printer deletion confirmation dialog box appears. Click “Yes”.

= Areyou sure you want to remove this device?

FUIIFILM ASK-400

=

Figure 4.2.3 Printer deletion confirmation dialog box

3) After deleting the FUJIFILM ASK-400 printer, select another printer (for example, Fax), and then
click “Print Server Properties” in the menu bar.

&# Devices and Printers

&~ v v I « Hardware and Sound » Devices and Printers | Search Devices and Printers el

File Edit View Tools

Add a device Add a printer See what's printing Remove device = - o

~

Fax Model: Microsoft Shared Fax Driver
$ Category: Fax
Status: 0 document(s) in queue

Figure 4.2.4 Displaying the Print Server Properties menu in the Devices and Printers screen
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4) The Print Server Properties dialog box appears. Click the “Drivers” tab. From the installed printer
driver list, select FUJIFILM ASK-400, and then click “Remove...”.

#mt Print Server Properties

Foms F'nrtsSecurity Advanced
;! -

Installed printer drivers:

Processor

e espele

&5 Change Driver Settings

Cancel Apply
Figure 4.2.5 Printer Server Properties dialog box

5) The Remove Driver and Package dialog box appears. Select “Remove driver only”, and then
click “OK”.

Remave Driver And Package

Do you want to remove the driver(s) only, or remove
the driver(s) and driver package(s) from your system?

)

(@

(O Remnove driver and driver package.

Figure 4.2.6 Remove Driver And Package dialog box
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6) The Print Server Properties confirmation dialog box appears. Click “Yes”.

Print Server Properties

| Deleting this printer driver will remove it
from the system. Are you sure you want
to delete FUJIFILM ASK-400?

Yes No

Figure 4.2.7 Driver deletion confirmation dialog box

If the following message appears, the operating system may be using the driver (Print Spooler
service) in the background. Disconnect the USB cable and then restart your computer and try
deleting the printer driver again.

Print Server Properties

Unable to remove FUJIFILM ASK-400,
%86, Type 3 - User Mode driver.

The specified printer driver is currently in
use.

Fig 4.2.7.i Driver in use

7) In the Print Server Properties dialog box, confirm that FUJIFILM ASK-400 was deleted, and then
click “Close”.

st Print Server Properties

Forms Ports  Drivers  Secuity Advanced
5

Installed printer drivers:

Name Processor Type

GChanga Driver Settings
Cancel Apply
Figure 4.2.8 Print Server Properties
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